
DiCentra Outstanding and Fixed Bugs 
Release 3.8.139 

 

Page 1  13 Jun 2011 

Recent History 
Here is a quick summary of recent changes in the public release.  The full history is at the 
end of this document. 

 

Release Changes 

R 3.8.139 

14 Jun 11 

Preferences 

 It is now possible to suppress the display of image numbers during a 
competition using the Image Details tab in Edit > Preferences. 

 DiCentra would crash if Background Image was set on the Title tab but 
no image was chosen.  You are now required to select an image 
before you are allowed to save the preferences if you select 
Background Image.  

All-Comers Comps  

 A bug caused All-Comers rules to revert to club comps sometimes 
during editing.  This resulted in the loss of club details when the 
competition was generated.  This has been fixed. 

 It is now possible to use the Navigator to select all entries from a given 
club in All-comers comps using sequences that are automatically 
generated for each club.  This is in addition to selection of entrants by 
their name. 

Large Inter-Club Comps 

 These comps now accept reference codes that begin with either letters 
or digits and may contain a mixture of the two. 

Loading Images  

 Large sequence numbers are now acceptable again.  This fixes a 
restriction introduced in version 3.8.131.  (Some clubs use this to 
encode the sequence number and an entrant code.) 

 Underscores in titles could result in incorrect parsing of file names.  
When such file names are found during loading now, the information is 
presented to you to manually sort it. 

 In rare cases the order in which images were loaded was not in 
ascending file name order.  This has been fixed. So, if images have a 
sequence number at the start of the file name, image ‘1 Moonlight.jpg’ 
will be processed during loading before ‘4 Sunset.jpg’.  Note that ’04 
Sunset.jpg’ will still be loaded before ‘1 Moonlight.jpg’ so ensure that 
all images have the same number of digits in their sequence number. 

 Previously, an 8-bit monochrome image that had an sRGB profile 
would cause DiCentra to crash when an attempt was made to display 
the image in the competition.  DiCentra now rejects such improper 
image files during loading. 

Spreadsheets 

 Spreadsheets could not be input to Excel 97 and in Open Office 
showed a few garbage characters at the start.  An option is now 
available to output spreadsheets as ASCII for such cases only.  Note 
that the ½ symbol is replaced by ‘?’ when this is used. 

 When spreadsheets were merged to accumulate the results of several 
competitions, the columns could be misaligned if an entrant was not 
included in an earlier competition.  This has been fixed. 
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Release Changes 

 

R 3.8.131 

3 Dec 10 
 If the # character is used in folder names to include a comment and 

there is a dot immediately before it, then DiCentra erroneously 
reported that a .wie file had been loaded.  This has now been 
corrected. 

 For competitions where a sequence number is expected at the start of 
image file names, DiCentra could hang if this is missing and the image 
title started with a large number, e.g. “77777 trombones.jpg”.  This has 
been fixed. 

 The dialogue for editing image filenames that do not match the 
expected format has been improved to reduce re-typing. 

 Function key F2 can now be used to alternately start a slide show from 
the beginning or stop it. 

 If places were added as awards in place-marked competitions the 
results were not shown in the correct order.  This has been fixed. 

 Fonts for text displayed during a competition are now scaled to avoid 
layout problems when Windows is configured with font scaling of more 
than 100%. 

R 3.8.126 

20 Sep 10 
 When creating new rules, surplus spaces in the competition name 

would cause an error report to be produced.  This has been fixed. 

 Under some circumstances the sRGB profile, and possibly others, did 
not show in the drop-down list of available profiles on the main 
DiCentra screen.  This has been fixed. 

R 3.8.125 

1 May 10 
 PageDown and PageUp can now be used to move forward and back 

through images.  This is useful for some presenter devices. 

 Folders on CDs that have a blank at the end of their name caused an 
error when loading.  (Windows won’t allow them to be copied either.)  
A message is now displayed indicating how to recover such folders. 

 Windows 7 sometimes changes the name of an image’s Adobe RGB 
colour space to opRGB.  DiCentra now handles this without comment 
if the competition colour space is Adobe RGB.  Adobe RGB variants, 
such as ‘Epson Adobe RGB’ are also accepted. 

 The status panel is minimised once the competition is made.  It can be 
expanded manually. 

 New awards have been added for Very Highly Commended, Highly 
Commended, Commended, Best in Exhibition and Judge’s Choice.  
See the User Guide p. 56 for normal keyboard commands and p. 43 
for Lightbox commands. 

 The Lightbox now allows sorting by Award or Award Reversed. 

 The Held status of images can be changed in the Lightbox. 

R 3.7.121 
23 Mar 10 

 Some entries were not printed at a page break when the Blank 
Scoresheet was printed from Wordpad.  This has been fixed. 

R 3.7.119 
15 Feb 10 

 On some Windows 7 systems colour management was not correctly 
restored when DiCentra closed.  This has been fixed. 

R 3.7.117 

21 Nov 09 
 A ‘Save’ button has been added to the Navigator to ease the process 

of saving selections as sequences, and adding or removing sets of 
images from sequences. 
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Release Changes 

 For inter-club competitions using ‘by’ as a separator, all capitalisations 
of the word are now accepted. 

 When you run a competition, back-arrow now allows stepping from the 
competition banner page to the last image.  This also works when a 
sequence, such as held images, is being shown. 

 A problem with rules editor apparently reverting to include a reference 
number in Large Interclub competitions has been fixed. 

 A problem with unreadable rules files has been fixed.  It occurred with 
competition dates greater than 12th of the month on machines with 
different regional settings to the machine on which the rules had been 
created. 

 The range of display/projector sizes in rules and preferences has been 
expanded. 

R 3.6.114 

23 Oct 09 
 When making interclub comps and some clubs had too few entries, a 

dialogue was presented with no OK button.  This has been fixed. 

 On some systems the Load Entry progress bar could get hidden 
behind the main DiCentra Window.  This has been fixed. 

 Closing DiCentra when it was apparently stuck could cause Log files to 
remain locked.  This has been fixed. 

 On some systems there were reports of DiCentra reporting it was 
unable to read certain rules files on startup or after importing them.  It 
is now less sensitive to certain variations in Rules files. 

 An extra field ‘ESeq’ has been added to spreadsheet reports.  This is 
the entrant’s number for the image (in the range 1 to max. images per 
person or per club). 

R 3.6.112 

16 Oct 09 
 Spreadsheet reports by author can now be generated for All-Comers 

competitions.  The results for all images by a given author are 
contained in one row of the .csv file. 

 It is now possible to export and import results-only.  This can be useful 
after a competition when exporting the results back to a 
desktop/master machine. 

 A “x:\ Disk full” message was erroneously produced when a file with a 
long name was imported or exported.  A more informative message 
has been added. 

Note: The full names of files will change slightly when a competition is 
moved between machines.  Occasionally this results in their length 
becoming greater than the Windows limit of 256 characters. If an error 
message occurs, try re-importing just the rules and competition.  If this 
is still not successful you will need to go back to the original images or 
folders and shorten the offending names before exporting again.  

R 3.6.111 

25 Sept 09 
 Typing the ‘c’ command in a competition to clear all held images now 

asks for confirmation 

 The Light Box can now be used for marking place-marked 
competitions.  Just select a thumbnail and type its position (1-9) or 0 to 
clear its place 

 This change means that the Arrange > By Place and Arrange > By 
Place Reversed context menu commands now work for these 
competitions 
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Release Changes 

 A bug with ordering of place-marked competitions in the scoresheet 
has been fixed 

 Titles that include curly brackets no longer cause problems with 
printable reports 

 A sequence “No Titles” is now generated automatically for portfolio 
competitions for those who do not want title images to be seen 

R 3.6.108 

20 Sept 09 
 Fixes problems with renaming and deleting entrants in competitions 

with entry numbers 

 Importing ‘Rules and Competition Only’ fixed to leave log information 
undisturbed 

 Fixed problem with losing last character before # in folder names 

 Fixed to replace illegal filename characters by tilde (~) 

 Fixed to remove error when importing ‘Rules Only’ if there is no 
Assembly Area folder in the same folder 

 Added progress bar to indicate progress while making large 
competitions 

 Fixed unexpected error that occurred at the end of making a Multi-
Judge type competition 

R 3.6.105 

3 Jul 09 
 Fixes a problem where rules that do not use sequence numbers 

appear to revert to having a sequence number if they are re-opened 
with File > Open Rules. 

R 3.6.104 

21 May 09 
 Fixed problem that navigator did not correctly select clubs in large 

inter-club competitions 

R 3.6.103 

3 May 09 
 Includes a number of bug fixes 

R 3.6.102 

23 Apr 09 
 The short-hand marks entry for triple judge competitions has been 

fixed so that it now works as before. 

 The image number qualifier (Exactly, Maximum, Unlimited) for large 
inter-club competitions did not always show the correct setting.  This 
has been fixed. 

R 3.6.101 

14 Apr 09 
 Under certain circumstances the first filename component specified in 

a competition’s rules could get reset to ‘Sequence Number’ or 
‘Reference Number’ after the rules had been saved.  This has been 
fixed. 

 The ‘Don’t split into rounds’ option for score sheets has been fixed. 

R 3.6.99 

9 Apr 09 
 A new tie-break mechanism has been added for inter-club 

competitions.  An extra image from each club involved is ranked if a tie 
occurs.   

 Inter-club competitions that use this mechanism must have a 
sequence number for each image and the final one is taken to be the 
tie-break image. 

 A new Large Interclub Competition type has been introduced that 
allows a variable number of images per club, and allows reference 
numbers (e.g. C078123) to be included with the image name on 
reports. 

 On machines with internet access, it is now possible to check if you 
have the latest version and to access the DiCentra web page. 
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Release Changes 

 Options allow blank score sheets to be produced for judges without 
information identifying clubs or entrants. 

 Trial mode now allows all DiCentra features except projector setup to 
be used, but limits its use to competitions with no more than 3 entrants 
and 3 images per entrant. 

 A rare problem that caused a crash during a competition has been 
fixed.  This problem only occurred rarely, and only with monochrome 
images. 

 A rare crash on Vista machines when DiCentra starts has been fixed.   

R 3.5.92 
3 Mar 09 

 A text box that obscured part of competition images has been 
suppressed 

R 3.5.91 

1 Mar 09 
 A problem that caused DiCentra to produce an error at start-up on 

machines where the system dive was not C: has been fixed. 

 A problem where (very rare) images caused a crash during a 
competition has been fixed. 

R 3.5.88 

16 Feb 09 
 A problem that caused DiCentra to produce an error (and display an 

elephant) instead of the title slides for portfolio competitions has been 
fixed. 

R 3.5.87 

13 Feb 09 
 The progress bar that shows when images are being loaded should no 

longer obscure other dialogues. 

 There is a new shortcut to start a complete slide show: F2 – function 
key 2. 

 The separator between image number and title in portfolio image 
names can now be chosen from the usual range, including underscore.

 1050 x 1050 pixels is now an allowable image size. 

R 3.5.86 

6 Feb 09 
 A bug which caused DiCentra to crash when used in try-out mode has 

been fixed. 

 When All-comers competitions are made, the dialogue to choose the 
number of entries accepted is now of fixed size to prevent the OK 
button disappearing off the screen. 

 Some entrants accidentally include a dot at the start of an image’s title 
or include underscores instead of spaces.  These are now cleaned up 
automatically. 

R3.5.85 

2 Feb 09 
 The limit on number of entries per club for inter-club competitions has 

been removed. 

 A progress bar is now shown when loading images and the need to 
click ‘OK’ after each entrant’s images have been loaded is now 
optional. 

 All appropriate installed profiles are now shown in the profile list.  A 
bug in colour processing has been fixed. 

 Shortcuts have been added to allow quick switching to show held 
images on the lightbox (‘x’) and to view held images (<down arrow>).   

 New awards have been added for 1st, 2nd, 3rd and 4th place and Hon. 
Mention.   

 Awards can now be added using <Alt>+x, where x is 1, 2, 3 or 4 for 1st, 
2nd, 3rd or 4th.   It is g, s, b, r for gold, silver, bronze or ribbon, and c, m 
or w for certificate, Hon. Mention or winner. 
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Release Changes 

R3.5.79 

3 Dec 08 
 A warning is now displayed when you load images for a competition 

using Adobe RGB (1998) working space if the profile is not already 
installed on the machine. 

 If you suppress initial titles, they no longer briefly appear as you move 
to the next image while the marks are displayed for the previous one. 

 It is no longer necessary to include sequence numbers in the entrant’s 
image filenames for club and inter-club competitions. 

R3.5.76 

1 Nov 08 
 New Multi-judge competition support added.  This allows more flexible 

support for certain types of competitions with between 2 and 5 judges. 

R3.4.70 

8 Oct 08 
 In large competitions, a problem with the previous image’s details 

being shown momentarily when marks were entered has been fixed. 

R3.4.69 

6 Oct 08 
 If club names are included in all-comers competitions, they are now 

included in the printable results, on-screen scoresheet and the results 
spreadsheet. 

R3.4.68 

24 Sep 08 
 Download size has been reduced from about 25 Mbytes to about 7 

Mbytes. 

 The Certificate selector was not enabled in the Navigator if certificates 
were awarded using the Lightbox.  This has been fixed. 

 Titles that contain an ‘&’ character now display correctly in the on-
screen image details. 

 Progress bar for Import/Export of competitions should not now stall for 
large competitions.  (Copying did continue even though there 
appeared to be no progress.) 

 

Release Numbering 
DiCentra release numbers have the following meaning: 

 First number: Major release number.  This changes when substantial changes 
have been made. 

 Second number: Minor release number.  This changes whenever new features 
have been added to the previous release. For example, release 2.1.19 has some 
extra features dealing with projector setup compared to version 2.0.17. 

 Third number: Build number.  This will change when bug fixes have been applied 
or with a minor release.  Thus, when some bugs in 2.0.16 were fixed the release 
number changed to 2.0.17. 

Reported Issues Awaiting Full Solution 
The following are known limitations or bugs.  

 

No. Date Details 

B3.31 24/9/09 Symptoms: A message beginning “DisplayInfo.RB_GetScreenIndex 
…” is sometimes displayed when only the projector is 
being used on a laptop (not using laptop screen). 

Fix: Dismiss the message.  It should only occur once at the start 
of a competition or projector setup. 

Status:  No fix available at present. 



DiCentra Outstanding and Fixed Bugs 
Release 3.8.139 

 

Page 7  13 Jun 2011 

No. Date Details 

B3.30 1/5/09 Symptoms: Opacity setting in Preferences has no effect on opacity 
of image details panel during a competition. 

Fix: No fix at present.  It is thought that the display adaptor on 
the machines affected does not support certain features that 
are needed. 

Status:  No fix available at present. 

B3.29 20/3/09 Symptoms: When DiCentra was run on one Vista machine, DiCentra 
crashed immediately.   

Fix: This has been fixed, but there could still be a problem 
installing the licence on such machines.  Contact 
software@wilburimaging.com for a workaround if this affects 
you. 

Status:  Partially fixed in 3.6.99.  A full fix will be available shortly. 

B3.28 8/3/09 Symptoms: DiCentra’s policy is only to change image files that do 
not meet the competition’s rules.  However, it has been 
noticed that where Tiff files are allowed they get 
converted to JPEGs for the competition. 

Fix: None. 

Status:  This will be fixed shortly. 

B3.24 2/2/09 Symptoms: A beep is sounded when adding an award in the 
lightbox using <Alt>+code. 

Fix: None. 

Status:  Although the beep is annoying the award is correctly added 
(or removed). 

B3.22 13/1/09 Symptoms: Installing .NET 1.1 runtime (needed by DiCentra) on 
Vista can fail. 

Fix: Contact software@wilburimaging.com  

Status:  This is very rare.  .NET 1.1 runtime needs to be installed for 
DiCentra to work (even if .NET 2.0 or .NET 3.5 are already 
installed.  The problem is being investigated, but contact us 
if this affects you. 

B3.19 31/10/08 Symptoms: Images extracted for judges’ preview may contain 
information that can identify the author.  

Fix: None 

Status:  It is relatively easy to remove EXIF data, but other forms of 
identification also exist in image files.  Further efforts to 
remove this will be made if there is sufficient demand.  

B3.15 25/8/08 Symptoms: For competitions with entry numbers, the status panel 
does not show the entry number.  

Fix: None 

Status:  Will be added later 

B3.1 1/8/07 Symptoms: With Vista, some text in Status/Log may get cropped  

Fix: None 

Status:  Being investigated 
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No. Date Details 

B3.2 12/8/07 Symptoms: Saving marks and generating the lightbox screen can 
be slow for large competitions (> 500 images)  

Fix: None 

Status:  Update being developed 

B3.5 12/8/07 Symptoms: ‘Lose last’ and ‘Lose random’ tie-break policies are not 
implemented 

Fix: None 

Status:  Being investigated 

B3.6 12/8/07 Symptoms: A folder for the entrant or club name needs to be 
included in the rules 

Fix: If entries are submitted on CD or USB memory stick without 
the relevant folder, DiCentra prompts for the entrant name.  
Alternatively, a suitably named folder can be created on 
hard disk into which the entries can be copied.  They can 
then be loaded from this folder. 

Status:  Being investigated 

B3.7 12/8/07 Symptoms: User Guide pagination is erratic 

Comment: Chapters should start on right hand pages but some start on 
left hand pages and there are sometimes spurious blank 
pages between chapters thanks to Word. 

Status:  One day it may get fixed … 

B3.11 12/2/08 Symptoms: Sample folders and/or rules do not get installed 

Comment: In a small number of installations the sample files do not get 
properly installed.  The projector test chart image also 
sometimes goes missing. 

Status:  Being investigated. 

B3.13 12/2/08 Symptoms: Image number in image details is compressed and 
unreadable 

Cause:  This is believed to be due to display driver settings.  Check 
Control Panel > Display > Settings > Advanced > General > 
DPI Setting. The normal setting is 96 dpi for modern 
displays.  If it is set to 120 dpi this is likely to be the problem.

Status: Please contact us if you experience this problem and this 
does not fix it. 

B3.14 12/2/08 Symptoms: On SXGA+ projectors (1400 x 1024 or similar) part of the 
Lightbox and Scoresheet windows are inaccessible 

Cause:  This is believed to be due to display driver settings.  Check 
Control Panel > Display > Settings > Advanced > General > 
DPI Setting. The normal setting is 96 dpi for modern 
displays.  If it is set to 120 dpi this is likely to be the problem.

Status: Please contact us if you experience this problem and this 
does not fix it. 
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Fixed Bugs 

No. Date Details 

B3.34 20/10/09 Symptoms: Reports of ‘xxx log’ file is locked when starting DiCentra 
and selecting a competition 

Cause: Bug. 

Status:  Fixed in 3.6.114 

B3.33 23/10/09 Symptoms: When making an inter-club competition where one or 
more entrants has insufficient images a dialogue is 
presented without an OK button. 

Cause: Bug. 

Status:  Fixed in 3.6.114 

B3.32 22/10/09 Symptoms: When DiCentra is started a couple of ‘Can’t read xxx 
Rules’ are displayed.  There may also be problems 
importing exported competitions. 

Cause: Bug. 

Status:  DiCentra is now less sensitive to certain acceptable 
variations in Rules files. Fixed in 3.6.114 

B3.31 3/7/09 Symptoms: If rules that do not use sequence numbers for images 
are re-opened using File > Open Rules … the first field 
in the filename appears as Sequence Number.    

Cause: Bug. 

Status:  Fixed in 3.6.105 

B3.27 8/3/09 Symptoms: Sometimes an invalid profile is added to a 
monochrome image file when it is loaded.  This causes 
DiCentra to crash during the competition. 

Cause: Bug. 

Status:  Fixed in 3.6.99 

B3.26 28/2/09 Symptoms: Very rarely an image file will load correctly but will 
cause DiCentra to crash when run in a competition 

Cause: This is due to an inconsistency in the profile information in 
the image file 

Status:  Fixed in 3.5.91 

B3.25 28/2/09 Symptoms: On machines whose system drive is not C:, DiCentra 
fails to start 

Cause: Coding limitation. 

Status:  Fixed in 3.5.91 

B3.23 19/1/09 Symptoms: Very occasionally the list of projector profiles is 
incomplete, usually only showing ‘sRGB color space 
profile.icm’ 

Cause: The cause is unknown but DiCentra has been fixed to list 
all appropriate installed profiles. 

Status:  Fixed in 3.5.85 
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No. Date Details 

B3.20 3/12/08 Symptoms: DiCentra gave an unexpected error message when 
attempting to correct an image’s working space to 
Adobe RGB (1998) if that profile was not installed on 
the machine.   

Note: This only applies to competitions expecting images in the 
Adobe RGB (1998) working space.  The profile needs to be 
installed from the Adobe web site, and DiCentra now 
provides polite warnings of the problem. 

Status:  Fixed in 3.5.79 

B3.21 3/12/08 Symptoms: When set to suppress the initial display of titles during 
a competition, the title could still appear briefly if the 
next image was selected while the previous marks and 
title were on the screen.  

Status:  Fixed in 3.5.79 

B3.18 20/9/08 Symptoms: When exporting or importing large competitions, the 
progress bar sometimes appears to stall.  Copying still 
continues, even though there is no visible sign of 
activity.  

Status:  Fixed in 3.4.68 

B3.17 20/9/08 Symptoms: For some competitions the Certificates selector in the 
Navigator is not enabled, even though certificates have 
been awarded.  

Status:  Fixed in 3.4.67 

B3.16 25/8/08 Symptoms: The DiCentra download file has doubled in size due to 
extra samples that have been included.  

Status:  Fixed in 3.4.67 

B3.3 12/8/07 Symptoms: Names that contain accented characters do not print 
correctly in reports  

Status:  Fixed in 3.0.23 

B3.4 12/8/07 Symptoms: Files encoded as ‘Progressive JPEG’ are rejected as 
bad files 

Fix: Re-process the image saving it as ‘Baseline’ coding. 

Status:  Fixed in 3.2.45 

B3.8 12/10/07 Symptoms: If there is a gap in an entrant’s image numbers or they 
do not start at 1 the error ‘clsEntries:SaveV3Entry:Object 
reference not set to an instance of an object’ occurs  

Status:  Fixed in 3.1.34 

B3.9 15/10/07 Symptoms: Attempting to load images larger than specified in the 
rules can produce ‘ … A generic error occurred in GDI+’.  If 
you click OK then error B3.8 above will occur too  

Fix: Resize the images in an imaging application for now and try 
again. 

Status:  Fixed in 3.1.34 
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B3.10 6/10/07 Symptoms: Some images with apparently valid colour profiles are 
being flagged as ‘fixed’ 

Cause:  Photoshop CS3 uses a different method of indicating colour 
space of images.  Please report any cases where images 
originating from other applications give similar symptoms.   

Fix: No action needed for sRGB competitions.  Contact 
software@wilburimaging.com if you are using Adobe RGB 
for competitions. 

Status:  Fixed in 3.2.45 

B3.12 12/2/08 Symptoms: Problems running from an account without 
Administrator privileges 

Comment: In a few cases there seem to be problems running 
DiCentra from an unprivileged Windows account.   

Note: Please contact us if you experience these problems. 

Status:  Fixed in 3.3.51 

B3.15 20/3/08 Symptoms: Exporting files to a disk with inadequate space causes 
repeated error messages 

Status: Fixed in 3.3.51 

B3.16 29/4/08 Symptoms: Running DiCentra from a non-Administrative account 
caused it to crash. 

Status: Fixed in 3.3.53 

B3.17 30/4/08 Symptoms: Some image files cause unexpected error when being 
loaded. 

Status: Fixed in 3.3.53 
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Release History 
Here is a quick summary of changes in the public releases. 

 

Release Changes 

R3.5.79 

3 Dec 08 
 A warning is now displayed when you load images for a competition 

using Adobe RGB (1998) working space if the profile is not already 
installed on the machine. 

 If you suppress initial titles, they no longer briefly appear as you move 
to the next image while the marks are displayed for the previous one. 

 It is no longer necessary to include sequence numbers in the entrant’s 
image filenames for club and inter-club competitions. 

R3.5.76 

1 Nov 08 
 New Multi-judge competition support added.  This allows more flexible 

support for certain types of competitions with between 2 and 5 judges. 

R3.4.70 

8 Oct 08 
 In large competitions, a problem with the previous image’s details 

being shown momentarily when marks were entered has been fixed. 

R3.4.69 

6 Oct 08 
 If club names are included in all-comers competitions, they are now 

included in the printable results, on-screen scoresheet and the results 
spreadsheet. 

R3.4.68 

24 Sep 08 
 Download size has been reduced from about 25 Mbytes to about 7 

Mbytes. 

 The Certificate selector was not enabled in the Navigator if certificates 
were awarded using the Lightbox.  This has been fixed. 

 Titles that contain an ‘&’ character now display correctly in the on-
screen image details. 

 Progress bar for Import/Export of competitions should not now stall for 
large competitions.  (Copying did continue even though there 
appeared to be no progress.) 

R3.4.65 

26 Aug 08 
 Additions to the Vista fix (R3.3.54) to deal with earlier partial licence 

installation. 

R3.4.64 

23 Aug 08 
 Entry numbers can be assigned to each entrant as their images are 

loaded, provided the rules are configured appropriately. 

 Competitions where portfolios of related images) are to be judged are 
now supported by DiCentra. 

 It has always been possible for entrant names to be entered in 
surname-first format, but now, if the rules indicate this, the fields 
produced in results spreadsheets are correct.  Where Entry Numbers 
are also specified in the rules, reports can be produced in Surname or 
entry number order. 

 Marks can now be suppressed in printable reports. 

R3.3.54 

11 Aug 08 
 After installing a licence for DiCentra on Vista, an error message 

asking for DiCentra to be run once from an administrator account was 
shown, even if the current account had administrative privileges. This 
has been fixed.  

R3.3.53 

4 May 08 
 Some image files (possibly generated by ACD software) caused 

DiCentra to give an unexpected error.  This has been fixed. 

 When running DiCentra from a non-Administrative Windows account it 
crashed.  This has been fixed. 
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R3.3.51 

24 Mar 08 
 Export/Import has an additional option to transfer only those files 

needed for a competition.  This can significantly reduce the file space 
needed and the transfer time.   

 It is now possible to extract all or just a sequence of images and 
thumbnails from a competition.  This can be useful for sending to the 
judge beforehand, providing a handful of images at the start of a 
competition for normalisation of judging, or for extracting images and 
thumbnails for building a web site. (Competition > Extract) 

 Sequences can now be built manually as an alternative to using the 
Lightbox.  They can also be edited.  This is useful in connection with 
the Extract function and also for selective report generation. 
(Competition > Edit Sequence and Competition > Delete Sequence) 

 If DiCentra is licensed on a particular machine, all users are now 
licensed, without needing to install the licence for each user account 
individually.  This takes effect from the time when the new version of 
DiCentra is first used. 

 Multiple different licences can be installed on one machine and the 
relevant one can be selected.  This may be useful where the same 
computer is used by a licensed club and is also used by a licensed 
federation of clubs. 

 A number of bugs have been fixed: 

o DiCentra would not start correctly even in trial mode under 
Windows accounts without Administrator privileges.  This has 
now been fixed. 

o If licence installation failed because of an incorrect licence 
image, subsequent attempts to install the licence would fail until 
the licence image was removed manually.  Failed licence 
installation attempts now automatically remove the associated 
licence image. 

R3.2.45 

14 Feb 08 
 Competition details, before or after marking, can now be exported for 

processing by a spreadsheet package such as Excel. 

o The File > Reports menu has been extended to include 
Printable Reports and Spreadsheet Reports as options. 

o For interclub and all-comers competitions each spreadsheet 
row contains the details of one image. 

o For club competitions this same row-per-image format can be 
produced. Alternatively, an entrant-per-row format is available 
and places details of all their images on the same row. 

o If several club competitions are run as part of a series, 
DiCentra can merge the current results into an earlier set of 
results.  Merging can only occur for exact matches of entrant 
names.  Some manual fixing of the spreadsheet may be 
needed where entrants use different forms of their names in 
different heats of the series.  For example, John Smith ARPS 
and John T Smith ARPS would appear as two separate rows 
even if they were the same person. 

o An application note describing this new feature in more detail 
will be produced shortly. 

 The Auto Cert drop down in the Rules dialogue has been extended to 
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show the top 5 possible marks. 

 It is now possible to prevent displaying the image details when an 
image is first shown.  This can be useful for the initial run through of all 
images, or because you prefer it.  The details are still displayed when 
marks are entered or the Ctrl or # keys are pressed.  To use it: 

o Edit > Preferences > Image details and uncheck Show Details 
Initially, or 

o Use the context (right-click) menu and click Initial Details to 
toggle the setting on or off.  Each time you run the competition 
this is set to the Preferences setting above, or 

o Type D on the keyboard to toggle the current setting. 

 A number of bugs have been fixed: 

o Some JPEG images with correct colour space were flagged as 
having the wrong colour space and were ‘fixed’.  This seems to 
be a problem with some files produced by Photoshop CS2 and 
CS3.  DiCentra has been changed to deal with such files 
correctly. 

o Processing of entrants’ images has been re-worked.  In a 
number of cases where ‘bad’ files are detected, the reason is 
now given in DiCentra’s log. 

o Images with large printer profiles as the colour space no longer 
cause a crash, and should be processed correctly to the target 
colour space if the rules allow. 

o If all images from an entrant were skipped or rejected an 
unexpected error ‘Malformed .wie file’ occurred.  This has been 
fixed.  

o After the Help panel was displayed and dismissed during a 
competition the keyboard appeared to stop working.  This has 
been fixed. 

R3.1.34 

1 Nov 07 
 The image details bar that is shown during competitions has been re-

worked: 

o Opacity of image details background can be controlled via 
Preferences to make it less obtrusive. 

o Awards are now shown in the details area. 

o Image details can be suppressed when an image is initially 
shown (Preferences).  In this situation they are still shown 
when marks are entered or on demand. 

o Users can substitute their own images for award badges (see 
User Guide). 

 The context (right-click) menu in the Lightbox now includes an Arrange 
by item.  

o This can be used to sort the images in the lightbox by mark, 
mark reversed or by image number. 

o Any unmarked images will be moved from the included set and 
added to the excluded set. 

o The two sets can be recombined by using Arrange by > 
Number, Include All 

 Awards (Gold, Silver, … Certificate) can be assigned in the Lightbox 
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by selecting the relevant thumbnail and typing the usual command 
letter (g, l, … * resp.).  Assigning an award to the same image again 
clears the award. 

 A number of bugs have been fixed: 

o Wrong sized images do not now cause ‘GDI+’ error 

o Images originating from CD can now be deleted.  This allows 
competitions and entrants to be deleted without giving an error. 

o Licence images originating from CD now work correctly 

o Gaps in image sequence numbering no longer give an ‘object 
reference’ error 

o When ‘Reject incorrect images’ is selected in the rules, 
incorrect images no longer give an ‘object reference’ error. 

R3.0.23 

27 Aug 07 
 A number of small bug fixes have been made.  These include: 

o The background colour was sometimes seen when moving 
from the title to an image in a competition.  This was more of a 
problem if image details were selected to be shown before the 
image. 

o The arrow characters were missing from the help screen (F1) 
when running a competition. 

o Accented characters are now produced correctly in reports 

o Deleting a competition now works without producing an error. 

o The average mark is now shown correctly in the competition 
statistics. 

o  The log report statistics captions have been changed for 
clarity. 

R3.0.22  
13 Aug 07 

 Initial product release – see the Release Notes for the changes from 
the Beta release 2. 

 
3rd December  2010 


